
RNA 9000 Purity & Integrity Kit
For the BioPhase 8800 System

Application Guide

RUO-IDV-05-13438-D April 2024



This document is provided to customers who have purchased SCIEX equipment to use in the operation of
such SCIEX equipment. This document is copyright protected and any reproduction of this document or
any part of this document is strictly prohibited, except as SCIEX may authorize in writing.
Software that may be described in this document is furnished under a license agreement. It is against the
law to copy, modify, or distribute the software on any medium, except as specifically allowed in the license
agreement. Furthermore, the license agreement may prohibit the software from being disassembled,
reverse engineered, or decompiled for any purpose. Warranties are as stated therein.
Portions of this document may make reference to other manufacturers and/or their products, which may
contain parts whose names are registered as trademarks and/or function as trademarks of their respective
owners. Any such use is intended only to designate such products as those manufacturers' products and
does not imply any right and/or license to use or permit others to use such manufacturers' and/or their
product names as trademarks.
SCIEX warranties are limited to those express warranties provided at the time of sale or license of its
products and are the sole and exclusive representations, warranties, and obligations of SCIEX. SCIEX
makes no other warranty of any kind whatsoever, expressed or implied, including without limitation,
warranties of merchantability or fitness for a particular purpose, whether arising from a statute or
otherwise in law or from a course of dealing or usage of trade, all of which are expressly disclaimed,
and assumes no responsibility or contingent liability, including indirect or consequential damages, for any
use by the purchaser or for any adverse circumstances arising therefrom.
(GEN-IDV-09-10816-E)

For Research Use Only. Not for use in Diagnostic Procedures.
Trademarks and/or registered trademarks mentioned herein, including associated logos, are the property
of AB Sciex Pte. Ltd., or their respective owners, in the United States and/or certain other countries (see
sciex.com/trademarks).
AB Sciex™ is being used under license.
Made in USA with Foreign and Domestic Components.
© 2024 DH Tech. Dev. Pte. Ltd.

EC Authorized
Person

AB Sciex Netherlands B.V.
1e Tochtweg 11,
2913LN Nieuwerkerk aan den Ijssel
Netherlands

AB Sciex Pte. Ltd.
Blk33, #04-06 Marsiling Industrial Estate Road 3
Woodlands Central Industrial Estate, Singapore 739256

RNA 9000 Purity & Integrity Kit For the BioPhase 8800
System
2/93

Application Guide
RUO-IDV-05-13438-D



Contents

1  RNA 9000 Purity & Integrity Kit.............................................................................................. 6
Safety........................................................................................................................................6
Intended Use.............................................................................................................................6
Introduction............................................................................................................................... 6

Workflow.............................................................................................................................. 7

2 Required Equipment and Materials.........................................................................................9
Storage Conditions..................................................................................................................10
Customer-Supplied Equipment and Supplies..........................................................................11
Required Detector................................................................................................................... 11
Required Cartridge..................................................................................................................11

Condition the Capillaries.................................................................................................... 12

3 Methods and Sequences........................................................................................................13
Methods and Sequences for the BioPhase Software..............................................................13
Methods for the Waters Empower™ Software......................................................................... 13
Create the Sequence.............................................................................................................. 14

4 Prepare the Samples.............................................................................................................. 17
Best Practices for Working with RNA......................................................................................17
Prepare the ssRNA Ladder.....................................................................................................17
Prepare the RNA Sample........................................................................................................18

5 Prepare the BioPhase 8800 System...................................................................................... 20
Load the Reagent Inlet and Outlet Plates............................................................................... 20
Load the Sample Inlet and Outlet Plates.................................................................................22
Examine the Capillary Cartridge............................................................................................. 24
Install the Capillary Cartridge..................................................................................................25

6 Run the Samples.....................................................................................................................28
Tips for Best Results............................................................................................................... 28

Use the Rinse Method........................................................................................................28
Guidance for Selection of the Injection Type......................................................................28

Start the Sequence from the Front Panel................................................................................31
Monitor the Run on the BioPhase 8800 Front Panel...............................................................33
Waste Disposal....................................................................................................................... 41

Application Guide
RUO-IDV-05-13438-D

RNA 9000 Purity & Integrity Kit For the BioPhase 8800
System

3/93



Stow the Cartridge After the Run............................................................................................ 41
Stow the Cartridge for Less than 24 Hours........................................................................ 41
Stow the Cartridge for More than 24 Hours....................................................................... 41
Prepare the Cartridge After Storage.................................................................................. 42

7 Analyze the Data..................................................................................................................... 43
Use an Analysis Parameters File to Analyze the Data............................................................43
Examine the Results............................................................................................................... 46
Review the Results on the Overlay Tab.................................................................................. 47
Guidance for Acceptance Criteria........................................................................................... 50

8 Run the Samples with the Waters Empower™ Software......................................................51
Import the BioPhase Software Methods to Create Instrument Methods.................................51
Create the Sample Set Method...............................................................................................54
Start the Sample Set Method..................................................................................................57
Monitor the Run in the Waters Empower™ Software...............................................................63

9 Troubleshooting......................................................................................................................66
Remove Blockage from a Capillary.........................................................................................78
Options for a Blocked or Damaged Capillary..........................................................................78

A Hazardous Substance Information....................................................................................... 79

B Download Required Files...................................................................................................... 80
Download and Configure the Required Files (BioPhase Software)........................................ 80
Download and Configure the Required Files (Waters Empower™ Software).......................... 81

C Reagents, Plate Layouts, and Methods................................................................................82
Reagent Set............................................................................................................................ 82
Plate Layouts.......................................................................................................................... 83
Methods.................................................................................................................................. 85

Conditioning Method.......................................................................................................... 85
Separation Method with Electrokinetic Injection.................................................................86
Separation Method with Pressure Injection........................................................................88
Shutdown Method.............................................................................................................. 89
Capillary Rinse Method...................................................................................................... 90

Contact Us.................................................................................................................................. 92
Customer Training...................................................................................................................92
Online Learning Center...........................................................................................................92
Purchase Supplies and Reagents...........................................................................................92
SCIEX Support........................................................................................................................92

Contents

RNA 9000 Purity & Integrity Kit For the BioPhase 8800
System
4/93

Application Guide
RUO-IDV-05-13438-D



Cybersecurity.......................................................................................................................... 92
Documentation........................................................................................................................92

Contents

Application Guide
RUO-IDV-05-13438-D

RNA 9000 Purity & Integrity Kit For the BioPhase 8800
System

5/93



RNA 9000 Purity & Integrity Kit 1
The RNA 9000 Purity & Integrity kit supplies the reagents and supplies for sample preparation
and the methods to separate RNA fragments by size and to quantify heterogeneity and
impurities that might exist in an RNA preparation.

This document gives instructions for sample preparation with the RNA 9000 Purity & Integrity
kit. It also gives instructions for data acquisition with the BioPhase software and the Waters
Empower™ software with the BioPhase 8800 driver for Empower™. This document also gives
instructions for data analysis of data acquired with BioPhase software. The analysis of data
acquired with the Waters Empower™ software must be done with the Waters Empower™

software.

Use the information in this application guide as a place to start. If required, change the injection
time, voltage, injection type, or other parameters to find the best conditions for the requirements.

Note: For instructions about how to use the system safely, refer to the document: Operator
Guide.

Safety
Refer to the safety data sheets (SDSs), which are available at sciex.com/tech-regulatory,
for information about the correct handling of materials and reagents. Always follow standard
laboratory safety guidelines. For information about hazardous substances, refer to the section:
Hazardous Substance Information.

Intended Use
The RNA 9000 Purity & Integrity kit is for laboratory use only.

Introduction
The RNA 9000 Purity & Integrity kit is designed for biopharmaceutical scientists working on next
generation RNA therapeutics. This kit provides high analytical resolution, helps alleviate method
complexity, and simplifies transferability. The kit has been validated on both the PA 800 Plus and
BioPhase 8800 systems.

The methodology involves heat denaturation of an RNA sample followed by immediate cooling
in an ice water bath. This forces the nucleic acid into the structure that has the most consistent
mobility during the separation.

The RNA sample is separated by size in a bare-fused silica capillary containing a replaceable
polymer gel that provides sieving selectivity while concurrently limiting counter electroosmotic
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flow (EOF). The fluorescent labeling dye SYBR™ Green II RNA Gel Stain1 is added to the
polymer gel matrix during reagent preparation. The dye preferentially binds to RNA molecules so
that the RNA can be detected by laser-induced fluorescence (LIF) during the separation.

Two separation methods were developed for this application: one that uses an electrokinetic
injection, and the other that uses a pressure injection. Both methods provide size-based
separation for RNA molecules between 0.05 kb and 9 kb in approximately 40 minutes. For
information about the injection types, refer to the section: Guidance for Selection of the Injection
Type.

Workflow
The workflow has the following steps:

1. Identify the number of samples to be analyzed and the number of replicates.

2. For BioPhase software users:

a. Create or change the methods. Refer to the section: Methods.

b. Create the sequence and the sample and reagent plate layouts. Refer to the section:
Create the Sequence.

3. For Waters Empower™ software users:

a. Import the BioPhase software methods. Refer to the section: Import the BioPhase
Software Methods to Create Instrument Methods.

b. Create the sample set methods and the sample and reagent plate layouts. Refer to the
section: Create the Sample Set Method.

4. Prepare the samples. Refer to the section: Prepare the Samples.

5. Use the sample and reagent plate layouts to prepare the plates. Refer to the section: Plate
Layouts.

6. Put the plates in the BioPhase 8800 system. Refer to the sections: Load the Sample Inlet
and Outlet Plates and Load the Reagent Inlet and Outlet Plates.

7. Start data acquisition.

• BioPhase software: Start the sequence from the front panel. Refer to the section: Run the
Samples.

• Waters Empower™ software: Start the sample set method from the Waters Empower™

software with the BioPhase 8800 driver for Empower™. Refer to the section: Start the
Sample Set Method.

8. After the run, stow the cartridge. Refer to the section: Stow the Cartridge After the Run

1 SYBR™ is a trademark of the Life Technologies Corporation. SYBR™ Green II RNA Gel Stain is not available for
resale.
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9. Analyze the data.

• BioPhase software: When the sequence is complete, use the BioPhase Analysis
software to analyze the data. Refer to the section: Analyze the Data.

• Waters Empower™ software: When the sample set method is complete, use the Waters
Empower™ software to analyze the data. For data analysis instructions, refer to the
Waters Empower™ software guides and help file.

RNA 9000 Purity & Integrity Kit
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Required Equipment and Materials 2
Note: For items with a reorder part number, sometimes the reorder quantity is different than the
quantity in the kit.

Note: The RNA 9000 Purity & Integrity kit (PN C48231) is packaged as two parts: Nucleic
Acid Extended Range Purity & Integrity kit (PN 5087900) and ssRNA Ladder (0.05-9 kb) (PN
5088699). Neither part can be ordered separately.

Note: The ssRNA Ladder in the RNA 9000 Purity & Integrity kit (PN C48231) is shipped
separately from the other kit components.

Table 2-1 RNA 9000 Purity & Integrity Kit (PN C48231)

Component Quantity Reorder Part
Number

Nucleic Acid Extended Range Purity & Integrity Kit (PN 5087900) N/A

Acid wash/regenerating solution (100 mL) 1 5312349

CE Grade water (140 mL) 2 C48034

LIF Performance Test Mix (20 mL) 1 726022

Nucleic Acid Extended Range Gel (140 mL) 2 N/A

SYBR™ Green II RNA Gel Stain2 (500×) (0.11 mL) 7 N/A

ssRNA Ladder (0.05-9 kb) (PN 5088699) N/A

ssRNA Ladder (0.05 kb to 9 kb) (70 μL) (shipped
separately)

2 N/A

Table 2-2 Other Supplies from SCIEX

Component Quantity Part Number

Capillary cartridge coolant (450 mL) 1 359976

Filter, 520 nm emission filter 1 144940

Sample Loading Solution 6 mL 608082

2 SYBR™ is a trademark of the Life Technologies Corporation. SYBR™ Green II RNA Gel Stain is not available for
resale.
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Table 2-2 Other Supplies from SCIEX (continued)

Component Quantity Part Number

BioPhase 8800 bare fused-silica capillary cartridge
(50 µm i.d. × 30 cm capillaries)

1 5080121

BioPhase 8800 outlet plates 20 5080315

BioPhase 8800 reagent plates 20 5080314

BioPhase 8800 sample plates 20 5080313

BioPhase 8800 Starter Plate Pack (4 sample plates, 4
reagent plates, 8 outlet plates)

1 5080311

Table 2-3 Other Required Reagents or Supplies

Description Vendor Part Number

Acrodisc 32 mm syringe filter with a 0.45 μm pore-size
membrane

Pall 4654

Luer-Lok tip disposable syringe (10 mL) BD 309604

(Optional) Nuclease-free water (10 × 2 mL) Integrated DNA
Technologies

11-04-02-01

(Optional) RNaseZap RNase Decontamination Solution
(250 mL)

Thermo Fisher
Scientific

AM9780

X-Pierce Film USA Scientific 2997-0100

Storage Conditions
• Upon receipt, to reduce photobleaching of the SYBR™ Green II RNA Gel Stain, remove the

SYBR™ Green II RNA Gel Stain3 from the box, immediately wrap it in aluminum foil, and then
keep at –35 °C to –15 °C.

• Upon receipt, keep the following at 2 °C to 8 °C:

• Nucleic Acid Extended Range Gel

• LIF Performance Test Mix

• Upon receipt, keep the ssRNA Ladder at –35 °C to –15 °C.

• Keep the remaining contents of the kit at ambient temperature.

3 SYBR™ is a trademark of the Life Technologies Corporation. SYBR™ Green II RNA Gel Stain is not available for
resale.
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Customer-Supplied Equipment and Supplies
• Powder-free gloves, neoprene or nitrile recommended

• Protective eyewear

• Laboratory coat

• Analytical balance

• Microcentrifuge, or equivalent, and nuclease-free microcentrifuge tubes (USA Scientific PN
1615-5510)

• PCR tubes, 0.2 mL flat-cap nuclease-free (VWR USA PN 20170-012 or VWR EUR PN
732-0548)

• Ice

• Pipettes and applicable nuclease-free tips

Note: For reagent plate preparation a repeater pipette or equivalent is recommended.

• Table-top mini centrifuge

• Vortex mixer

• Water bath or heat block capable of 37 °C to 100 °C

Required Detector
An LIF detector with a 488 nm excitation source and a 520 nm emission filter is required.

Required Cartridge
CAUTION: Potential Wrong Result. If a cartridge is used with the RNA 9000 Purity
& Integrity kit, then do not use the same cartridge for another application. If the
same cartridge with different buffers and sample types is used, then sample carryover,
nonspecific binding, and poor separation can occur.

A BioPhase 8800 bare-fused silica capillary cartridge with 50 µm inner diameter (i.d.) × 30 cm
capillaries is required.

Refer to the table: Table 2-2.
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Condition the Capillaries
CAUTION: Potential Wrong Result. Do not use a basic solution to clean the capillary.
The solution might negatively ionize the capillary wall and result in electro-osmotic
flow detrimental to the separation of nucleic acids. These interactions might cause poor
separation.

• Before a new cartridge is used, condition the capillaries with the Conditioning Method-
RNA 9000 method.

Required Equipment and Materials
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Methods and Sequences 3
Methods and Sequences for the BioPhase
Software
Note: If the validated methods and sequences are not included with the software, then they are
available for download from the SCIEX website. Refer to the section: Download and Configure
the Required Files (BioPhase Software). The methods can also be created manually with the
BioPhase software. Refer to the section: Methods.

The following methods and sequence are required.

• Conditioning Method-RNA 9000: Conditions the capillaries before first use.

• Separation methods:

• Separation Method with Electrokinetic Injection - RNA 9000: Does the
separation of the sample with an electrokinetic injection of the sample.

• Separation Method - Pressure Injection - RNA 9000: Does the separation of
the sample with an pressure injection of the sample.

• Shutdown Method - RNA 9000: Cleans the capillaries at the end of a sequence, rinses
the capillaries for storage, and then turns off the lamp.

• Capillary Rinse - RNA 9000: Rinses the capillary between sequences, if required.

• Sequence templates:

• RNA 9000 Test Sequence - Electrokinetic Sample Injection: A sequence
with the separation method that uses electrokinetic sample injection.

• RNA 9000 Test Sequence - Pressure Sample Injection: A sequence with the
separation method that uses pressure sample injection.

Methods for the Waters Empower™ Software
To create the required instrument methods, import the BioPhase software methods.

Note: If the methods are not included with the software, then they are available for download
from the SCIEX website. Refer to the section: Download and Configure the Required Files
(Waters Empower™ Software). The methods can also be created manually with the Method
Editors for BioPhase System software. Refer to the section: Methods.

Methods and Sequences
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Create the Sequence
Note: If the Waters Empower™ software will be used to acquire the data, then this procedure is
not applicable. Refer to the section: Create the Sample Set Method.

Note: This procedure is for users who know how to use the BioPhase software. For detailed
instructions, refer to the document: Software Help System.

This procedure gives instructions to create a sequence with a template that is supplied with the
BioPhase software.

Two templates are supplied: one that uses a separation method with an electrokinetic injection,
and the other that uses a separation method with a pressure injection. For information about the
injection types, refer to the section: Guidance for Selection of the Injection Type. The templates
are set up with the ssRNA Ladder in the first column, followed by 16 samples in the second and
third columns, and use the validated methods supplied with the software.

Sequences can also be created without a template. In most cases, a sequence should start
with a conditioning method, include separation methods, and then end with a shutdown method.
Usually, the shutdown method should be identified as the error recovery method. Refer to the
document: Software Help System.

Note: If the sequence includes replicate samples, then make that sure the replicates are in the
same row of the sample plate to decrease any capillary-to-capillary variation.

1. On the Home page of the BioPhase software, click Sequence Editor.

2. Click Open Sequence.
The Open a Sequence dialog opens.

3. Search for, and then select a sequence:

a. (Optional) Type a Start Date and End Date for the search, or click the calendar icons,
select the dates, and then click Search.
The available project folders are shown in the Folder Name pane.

b. Click the RNA 9000 project folder.
The available sequences in the project are shown in the table to the right.

c. In the table, click the sequence template, and then click Open.

• To inject the samples with an electrokinetic injection, click RNA 9000 Test
Sequence - Electrokinetic Sample Injection.

• To inject the samples with a pressure injection, click RNA 9000 Test Sequence -
Pressure Sample Injection.

The Open a Sequence dialog closes, and then the Sequence Summary tab opens.

Methods and Sequences

RNA 9000 Purity & Integrity Kit For the BioPhase 8800
System
14/93

Application Guide
RUO-IDV-05-13438-D



4. Above the Sequence Summary pane, click Edit.
The Sample Plate Setup tab opens.

5. If required, then do any of the following actions:

• Add or remove samples.

• Clear a method that is assigned to a sample well.

• Assign a different method to a sample well.

• In the Sequence Summary table, assign the recovery method to a method in the
sequence. Usually, the shutdown method should be identified as the recovery method.

For detailed instructions, refer to the document: Software Help System.

6. If required, edit the information in the Sequence Summary table.

Figure 3-1 Sequence Summary Table: RNA 9000 Test Sequence -
Electrokinetic Sample Injection

7. To see details of a run, click the + in the row with the run.

Methods and Sequences
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Figure 3-2 Sequence Summary Table Expanded

8. If required, change the information in the Sample Id and Data File columns.

9. To see the sample plate and reagent plate layouts, open the Plates Layout tab. If required,
change the reagent locations in the Reagent Plate pane.

10. To save the sequence, click SAVE, and then add the required information.

Note: If errors occurred, then the SAVE button is not available. Correct all of the errors in
the Validation pane, and then click SAVE.

11. (Optional) To print the sample plate and reagent plate layouts, do the following:

a. Click PRINT.
The Print Preview dialog opens.

b. Click Plate Layout Report, and then click Print.

c. Select the printing options, and then click OK.
The report is printed.

d. Close the Print Preview dialog.

Methods and Sequences
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Prepare the Samples 4
Best Practices for Working with RNA
Controlling RNase contamination is critical to the successful analysis of RNA. Precautions must
be taken to ensure RNA integrity prior to ssRNA ladder or RNA sample separation. RNases are
prevalent on human skin, perspiration, and saliva as well as bacteria and fungi spores and are
therefore ubiquitous to the lab environment. Proper laboratory procedures will help control RNA
degradation from RNases.

1. Wear gloves at all times and change gloves often when handling RNA samples.

2. Designate an RNase-free lab area and use RNase decontaminating reagents such as
RNaseZap RNase Decontamination Solution or MP Bio RNase Erase Decontamination
Solution for bench surfaces, lab racks, and micropipettors. Also, use a lab apparatus
capable of UV-light disinfection to help control RNase contamination.

3. Dedicate pipettes for RNA use and use filtered pipette tips that are certified nuclease-free to
decrease cross-contamination.

4. For anything that comes into contact with RNA, use nuclease-free plastic vials and labware.
Before adding any RNA, shield plasticware from environmental contamination by covering
and working in areas that limit airflow.

5. Use reagents such as nuclease-free water during RNA sample preparation. Use of Sample
Loading Solution or deionized formamide during RNA sample preparation promotes an
environment that stabilizes RNA and prevents RNA degradation from RNases.

Note: CE Grade water is not certified as nuclease-free.

Prepare the ssRNA Ladder
Note: Use the ssRNA Ladder as a qualitative reference for estimating the size of an unknown
RNA sample. It is not intended to be a quantitative standard.

1. Prepare the ssRNA Ladder.

a. For the initial run, remove the vial of ssRNA Ladder from the freezer, and then let it
thaw on ice.

b. With a vortex mixer, mix briefly for a few seconds, and then use a centrifuge to spin the
vial for a few seconds to bring the solution to the bottom of the vial.

c. Measure out the solution in 8 μL aliquots into nuclease-free PCR vials.

d. Reserve one aliquot, and then store the remaining aliquots at –35 °C to –15 °C.

Prepare the Samples
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2. Use one of the 8 μL aliquots of the ssRNA Ladder. If it is frozen, then thaw it on ice before
use.

3. Add the reagents in the following table to dilute the ssRNA Ladder.

Table 4-1 ssRNA Ladder Dilution

Reagent For 1 Sample For Up to 8
Samples

ssRNA Ladder 2 μL 17.5 μL

Sample Loading Solution 48 μL 420 μL

4. Heat the sample at 70 °C for 5 minutes.

5. After 5 minutes, immediately put the mixture in an ice water bath for a minimum
of 2 minutes.

Note: Rapid cooling forces the RNA into a structure that gives the best separation results.

6. Add 50 μL to 200 μL of the cooled diluted ssRNA Ladder to the sample plate well.

Note: In the sequence templates supplied with the BioPhase software, the ssRNA Ladder
must be present in all eight wells of column 1.

7. Make sure that, for any column on the sample plate with sample, the related column on the
sample outlet plate has 2.0 mL of gel buffer.

8. Put the sample plate in the system.

9. Make sure that the plate compartment temperature is set to 10 °C.

Prepare the RNA Sample
1. Thaw the RNA aliquot on ice.

Keep the sample cool to help prevent the RNA from degrading.

2. Prepare the RNA sample in Sample Loading Solution or nuclease-free water between
50 ng/mL to 50 μg/mL.
We recommend an RNA concentration between 1 μg/mL and 5 μg/mL.

Note: To use a higher sample concentration, decrease the PMT Gain in the Method
Settings tab in the separation method.

3. Heat the sample at 70 °C for 5 minutes.

4. After 5 minutes, immediately put the mixture in an ice water bath for a minimum
of 2 minutes.

Prepare the Samples
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Note: Rapid cooling forces the RNA into a structure that gives the best separation results.

5. Add between 50 μL and 200 μL to the sample plate well.

6. Make sure that, for any column on the sample plate with sample, the related column on the
sample outlet plate has 2.0 mL of gel buffer.

7. Put the sample plate in the system.

8. Make sure that the plate compartment temperature is set to 10 °C.

Prepare the Samples
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Prepare the BioPhase 8800 System 5
Use the procedures in this section to prepare the BioPhase 8800 system to acquire data.

Tip! To save time, turn on the light source 30 minutes before the start of the run to let it become
warm.

Load the Reagent Inlet and Outlet Plates
Note: The gel buffer and dye mixture is referred to as gel buffer in this document.

CAUTION: Potential Wrong Result. Do not prepare the gel buffer before it is required.
Degradation of the SYBR™ Green II RNA Gel Stain in the gel buffer might occur during
storage and cause peaks with decreased intensity.

Note: To prevent air bubbles, do not shake or vigorously mix the gel buffer. Air bubbles might
cause issues with the separation.

Note: Only X-Pierce film from USA Scientific has been validated for use. If a different film is
used, then test it before use.

CAUTION: Potential System Damage. Do not use a heated plate sealer to attach the
film cover. If the heat causes damage to the surface of the plates, then issues with the
pressure system might occur.

CAUTION: Potential Wrong Result. Before the plates are loaded in the system, spin them
to remove air bubbles. Air bubbles might an unsatisfactory separation.

CAUTION: Potential System Damage. Before the plates are loaded in the system, remove
the film cover. Do not load plates in the system before removing the film cover. If the film
cover is not removed, then damage to the capillary tips might occur.

1. Add the following reagents to a conical tube.

Table 5-1 Gel Buffer (Nucleic Acid Extended Range Gel with SYBR™ Green II RNA Gel
Stain)

Reagent For 1 to 48
Samples

For 49 to 96
Samples

Nucleic Acid Extended Range Gel 40 mL 60 mL

Prepare the BioPhase 8800 System
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Table 5-1 Gel Buffer (Nucleic Acid Extended Range Gel with SYBR™ Green II RNA Gel
Stain) (continued)

Reagent For 1 to 48
Samples

For 49 to 96
Samples

SYBR™ Green II RNA Gel Stain4 80 μL 80 μL

Tip! Wrap the tube that contains the prepared gel buffer in aluminum foil to decrease
photobleaching of the SYBR™ Green II RNA Gel Stain.

2. Carefully invert the tube a minimum of 20 times.
Make sure that air bubbles are not created when the tube is inverted.

3. With a 0.45 μm Acrodisc syringe filter and a Luer-Lok syringe, filter the gel buffer.

4. Use the reagent plate layout to add the following reagents to the reagent inlet and outlet
plates. Refer to the figure: Figure C-4.

Table 5-2 Reagents for the Reagent Inlet and Outlet Plates

Plate Reagent

Inlet plate 800 µL per well

Outlet plate • 2.8 mL of reagent per well for separation or wait positions

• 1.5 mL of CE Grade water per well for waste positions

Note: For the outlet plate, make sure that the chamfered corner is on the top right, and then
fill only the wells on the left side of the plate. The wells on the right side are for overflow and
must be empty.

5. Put a film cover on the plates.

6. Put the plates in a swinging-bucket rotor, and then spin them for 4 minutes at 30 × g. Make
sure that the buckets are balanced.

7. Make sure that there are no air bubbles in the plates. To remove air bubbles, then spin the
plates again at a higher relative centrifugal force (RCF).
For the reagent plate, the maximum RCF is 1,000 × g. For the sample plate, the maximum
RCF is 375 × g.

8. On the front panel, touch Eject Reagent.

4 SYBR™ is a trademark of the Life Technologies Corporation. SYBR™ Green II RNA Gel Stain is not available for
resale.
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Figure 5-1 Eject Reagent Button

The plate compartment opens.

9. Remove the film cover from the plates.

10. If the plate compartment contains reagent plates, then remove them.

11. Align the notch in the reagent inlet plate with the tab, and then put the plate in the plate
carrier.

12. Make sure that the chamfered corner of the reagent outlet plate is in the top left, and then
put the plate in the back of the plate carrier.

13. Touch Load Reagent.

Figure 5-2 Load Reagent Button

The plate compartment closes.

Load the Sample Inlet and Outlet Plates
CAUTION: Potential System Damage. Do not use a heated plate sealer to attach the
film cover. If the heat causes damage to the surface of the plates, then issues with the
pressure system might occur.

Note: Only X-Pierce film from USA Scientific has been validated for use. If a different film is
used, then test it before use.

1. Use the sample plate layout to add the samples to the sample inlet plate. Refer to the figure:
Figure C-3.
The recommended sample volume is 100 µL. The minimum sample volume is 50 µL. The
maximum sample volume is 200 µL.

2. To prevent damage to the capillaries, if there are columns where not every well has sample,
then add between 100 µL and 200 μL of sample buffer to each empty well.
In the sample plate layout, wells that should have sample buffer are shown in grey. If a
column has no samples, then the wells can be left empty.
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3. Use the sample plate layout to add the following reagents to the sample outlet plate. Refer
to the figure: Figure C-3.
The maximum volume is 2.0 mL.

Note: For the outlet plate, make sure that the chamfered corner is on the top right, and then
fill only the wells on the left side of the plate. The wells on the right side are for overflow and
must be empty.

Table 5-3 Reagents for the Sample Outlet Plate

Plate Reagent

Outlet plate • 2.0 mL of gel buffer per well

4. Make sure that, for any column on the sample plate with sample, the related column on the
outlet plate has 2.0 mL of separation gel.

5. Put a film cover on the plates.

6. Put the plates in a swinging-bucket rotor, and then spin them for 4 minutes at 30 × g. Make
sure that the buckets are balanced.

7. Make sure that there are no air bubbles in the plates. To remove air bubbles, then spin the
plates again at a higher relative centrifugal force (RCF).
For the reagent plate, the maximum RCF is 1,000 × g. For the sample plate, the maximum
RCF is 375 × g.

8. On the front panel, touch Eject Sample.

Figure 5-3 Eject Sample Button

The plate compartment opens.

9. Remove the film cover from the plates.

10. If the plate compartment already contains sample plates, then remove the sample plates.

11. Align the notch in the sample plate with the tab, and then put the plate in the plate carrier.

12. Make sure that the chamfered corner of the sample outlet plate is in the top left, and then
put the plate in the back of the plate carrier.

13. Touch Load Sample.
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Figure 5-4 Load Sample Button

The plate compartment closes.

Examine the Capillary Cartridge
WARNING! Puncture Hazard. Touch the cartridge carefully. The capillary tips are
extremely sharp.

CAUTION: Potential System Damage. Do not let the gel buffer or other reagents
crystallize on the electrodes, capillary tips, cartridge seals, or cartridge body. Electrolyte
salt crystals or precipitate can cause blocked capillaries, improper pressure sealing,
errors when injecting samples, arcing, or current leakage.

CAUTION: Potential System Damage. Do not use organic solvents, such as methanol or
acetone, to clean the capillary window. Organic solvents can dissolve the adhesives and
make a residue on the capillary window that causes interference with the detector.

1. Examine the electrodes, capillary tips, cartridge seals, and cartridge body before use.

2. If gel or liquid has collected on the outside of the cartridge, then clean the cartridge with a
moist laboratory wipe. After cleaning, make sure to dry the cartridge.

Note: Do not use soap or detergent to clean the cartridge.

3. If the capillary tips are blocked, then do this:

a. Use CE Grade water to clean the capillary inlets.

b. Use a lint-free laboratory wipe to clean the capillary inlets carefully in an outward
direction.

4. Use a magnifying glass to examine both sides of the capillary window. If lint or other
particles have collected, then use short bursts of electronics-grade compressed air to
remove them. Do not use water or other liquids to clean the capillary window.

5. Dampen a laboratory wipe or cotton swab with ethanol or isopropanol, and then clean the
surface of the ID chip. Let the ID chip air-dry before the cartridge is installed.
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Install the Capillary Cartridge
WARNING! Puncture Hazard. Touch the cartridge carefully. The capillary tips are
extremely sharp.

WARNING! Pinching Hazard. When the front panel is opened, do not put fingers to
the left of the front panel.

CAUTION: Potential System Damage. Make sure that the reagent plates are installed in
the system before the cartridge is installed. Otherwise, damage to the cartridge might
occur.

1. If the cartridge was kept in the refrigerator, then let the cartridge equilibrate to ambient
temperature for approximately 30 minutes to prevent condensation in the system.

2. Remove the cartridge from the wetting tray.

3. To prevent arcing, use a disposable laboratory wipe to dry the cartridge body to prevent
arcing.

4. Turn the bottom of the cartridge up.

5. Use a disposable laboratory wipe to very carefully dry the area where the capillaries and
electrodes come out of the cartridge. Do not touch or move the seals.
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Figure 5-5 Bottom of the Cartridge

Item Description

1 Outlet plate seal

2 Inlet plate seal

6. If the reagent plates are not installed in the system, then install them. Refer to the section:
Load the Reagent Inlet and Outlet Plates.

7. Open the front panel, and then put the cartridge in the system.

8. Close the front panel, and then touch EJECTED to lock the cartridge.

Figure 5-6 EJECTED Button
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The system moves the reagent plate until the capillaries are in position over column 1, and
then lifts the plate until the capillary tips are immersed in CE Grade water.

9. Examine the coolant level on the front panel. If required, add coolant to the system.
Refer to the section: "Add Capillary Cartridge Coolant" in the document: Operator Guide.
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Run the Samples 6
Tips for Best Results
SCIEX tested the separation performance of the ssRNA Ladder and other characteristics over a
range of temperatures. 30 °C is used in the separation methods because it gave the best overall
results.

If a specific characteristic is to be maximized, other temperatures can be used. Refer to the
table: Table 6-1.

Table 6-1 Guidance for Setting the Capillary Temperature

Capillary
Temperature (°C)

Capillary Run Life 9 kb Peak
Migration Time

(minutes)

Optimal Resolution by RNA
Length

3 kb to 5 kb ≥ 5 kb

25 Highest ~21

30 Higher ~20

35 Medium ~19

40 Lower ~17

Note: The capillary run life (the number of injections that can be done) depends on the sample
and the separation method. The preceding table shows how performance changes based on the
capillary temperature. In general, a lower temperature increases the capillary run life.

Use the Rinse Method
A rinse method is supplied with the other methods for the kit.

To save time after the capillary has been conditioned, in the sequence, use the Capillary
Rinse - RNA 9000 method as an alternative to the Conditioning Method-RNA 9000
method. The rinse method is approximately 30 minutes shorter than the conditioning method.

Guidance for Selection of the Injection Type
Two separation methods are supplied with the kit, one with an electrokinetic injection and one
with a pressure injection. This section gives an explanation of the differences between the
two types of injection. Select the separation method that is compatible with the goal of the
experiment.
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• Electrokinetic injection (EKI) uses an electric field to introduce the negatively charged RNA
into the capillary.

• Advantages: Assay sensitivity throughout the full separation range can be increased with a
larger injection volume or more concentrated samples.

• Disadvantages: Samples with higher ionic strength will have a lower signal intensity as a
result of injection competition between nucleic acids and anions in solution. ssRNA ladder
and sample peaks shorter than 300 bases might be more difficult to interpret and integrate
as a result of decreased peak selectivity during electrokinetic sample introduction.

• Hydrodynamic (pressure) injection uses pressure-over-liquid to introduce the sample to the
capillary.

• Advantages: Peak height is more consistent because the ionic strength in the sample does
not change from injection to injection. Peaks below 300 bases keep peak selectivity which
simplifies integration and analysis.

• Disadvantages: Assay sensitivity is decreased compared to electrokinetic injection.

The following figures show electropherograms of the separation of the ssRNA Ladder with the
different sample injection methods. (Only the peaks from 50 bases to 300 bases are shown.)
With electrokinetic injection the peak labeled 50 is much broader and thus has lower theoretical
plates as compared to the same peak from a pressure injection. Refer to the figures: Figure 6-1
and Figure 6-2.
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Figure 6-1 ssRNA Ladder Sample with Electrokinetic Injection, Annotated with Length and
Theoretical Plates
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Figure 6-2 ssRNA Ladder Sample with Pressure Injection, Annotated with Length and
Theoretical Plates

Start the Sequence from the Front Panel
To use the Waters Empower™ software, refer to the section: Start the Sample Set Method.

1. If required, load the cartridge, reagent plates, and sample plates.

2. On the front panel, touch RUN SEQUENCE.

Figure 6-3 RUN SEQUENCE Button

3. In the Projects pane, touch RNA 9000.

4. In the Available Sequences pane, touch the applicable sequence in the list.
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• For an electrokinetic injection, click RNA 9000 Test Sequence - Electrokinetic
Sample Injection.

• For a pressure injection, click RNA 9000 Test Sequence - Pressure Sample
Injection.

5. (Optional) To see the details of the method, sample plates, or reagent plates, touch
anywhere in the Method column.
To hide the details, touch the column or box again.

6. Touch Run Sequence.

Figure 6-4 Run Sequence Button

If the sequence contains a method that is incompatible with the system configuration, then
Run Sequence is not available.

The data files are saved at the location specified in the sequence. If this location has a data
file with the same name, then, to prevent the older data file from being overwritten, a date
stamp is automatically added to the file name.

If an error occurs during a run and an error recovery method is included in the sequence,
then the BioPhase 8800 system starts the error recovery method.

During the run, various actions are available. Refer to the section: Monitor the Run on the
BioPhase 8800 Front Panel.

When the run is complete, the Run Completed dialog opens.

Figure 6-5 Run Completed Dialog

7. To close the Run Completed dialog, touch OK.

8. If required, stow the cartridge. Refer to the section: Stow the Cartridge After the Run.
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Monitor the Run on the BioPhase 8800 Front
Panel
CAUTION: Potential System Damage. If the run is stopped, then sample or reagent might
be lost and damage to the cartridge might occur.

CAUTION: Potential System Damage. If the run is stopped and will not be started again,
then use the shutdown method to rinse the capillaries before the cartridge is stowed. If
the capillaries are not rinsed, then electrolyte salt crystals or precipitate can collect and
might cause blocked capillaries, incorrect pressure sealing, errors when the samples are
injected, arcing, or current leakage.

CAUTION: Potential System Damage. Before the run is started again, make sure to empty
or replace the outlet plate to prevent the overflow of reagent and possible damage to the
instrument.

CAUTION: Potential Wrong Result. Before the run is started again, prepare new reagent
plates. If the run has been stopped, then there might not be sufficient reagents available
to complete the run.

CAUTION: Potential Wrong Result. If the samples have been inside of the system for
more than 24 hours, sample degradation might have occurred. Discoursed the samples
before the run is started again.

Use this procedure to monitor the sequence progress, and then, if required, pause or stop the
sequence.

To use the Waters Empower™ software, refer to the section: Monitor the Run in the Waters
Empower™ Software.

Note: The sequence shown in the following figures is for the purpose of illustration. It does not
show a sequence for the RNA 9000 Purity & Integrity kit.

1. Monitor the traces for the detector and the current to make sure that the sequence is in
progress.

2. To stop the run, touch .
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Figure 6-6 Warning Dialog

3. Touch one of the following options:

• Yes: To start the error recovery method, if one is assigned.

• No: If an error recovery method is not assigned.

• Cancel: To continue the run.

4. If an error occurs, then touch OK in the error dialog that opens.
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Figure 6-7 Run Sequence Error Dialog

Note: The  shows an error at the Rinse action. The grey shading in the row above the
Rinse action shows that the action is in progress or completed.

5. Review the error:

a. On the Events tab of the front panel log, touch 

b. Touch Initialize System to initialize the system and change the system status to idle.
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Figure 6-8 Sequence Error Events Log

6. If required, then touch Pause Run.
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Figure 6-9 Run Sequence in Progress

To continue the run, touch Cancel Pause.
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Figure 6-10 Run Sequence Paused

7. To see the data during acquisition, touch  in the ribbon.

Note: The data in the following figure is for illustration only. It does not show results for
samples prepared with the RNA 9000 Purity & Integrity kit.
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Figure 6-11 Capillary View

8. (Optional) To zoom in on the data, do the following:

a. Touch Overlay.

b. Use two fingers to zoom in or out to see the electropherogram.

c. Use the hand icon to move the electropherogram.

Note: The zoom feature can only be used with the Overlay view for Detector and
Current.
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Figure 6-12 Zoom In or Out

9. Make sure that the message Sequence run Completed Successfully is shown when
the run completes. In the dialog, touch OK.

Figure 6-13 Run Completed Dialog
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If the system has been idle for 24 hours, then the cooler for the sample storage
compartment turns off.

Waste Disposal
WARNING! Biohazard or Toxic Chemical Hazard. Obey local directives
to discard chemicals, cartridges, reagent plates, sample plates, and the
remains of the prepared samples. They might contain regulated compounds
and biohazardous agents.

Stow the Cartridge After the Run
WARNING! Puncture Hazard. Touch the cartridge carefully. The capillary tips are
extremely sharp.

Stow the Cartridge for Less than 24 Hours
1. If the sequence or sample set method does not include the shutdown method, then use the

shutdown method to clean the capillaries.
The shutdown method fills the capillaries with CE Grade water and decreases the cartridge
temperature to 15 °C.

2. Keep the cartridge in the system for as long as 24 hours with the capillary tips immersed in
CE Grade water.

Note: If the cartridge has not been used for 3 hours or longer, then run the conditioning
method before a separation is done.

Stow the Cartridge for More than 24 Hours
1. If the sequence or sample set method does not include the shutdown method, then use the

shutdown method to clean the capillaries.
The shutdown method fills the capillaries with CE Grade water and decreases the cartridge
temperature to 15 °C.

2. On the ribbon on the BioPhase 8800 system front panel, touch  (Loaded), and
then wait for approximately 1 minute to let the coolant go back to the coolant reservoir
before the cartridge is removed.

3. Remove the cartridge from the system. Stow the cartridge upright in the cartridge box at
2 °C to 8 °C with the capillary tips immersed in CE Grade water.

Note: Replace the CE Grade water in the tray regularly to prevent microbial growth in the
tray.
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Prepare the Cartridge After Storage
• If the cartridge has not been used for more than a day, then use the Capillary Rinse -

RNA 9000 method to rinse the capillaries.

Note: To prevent arcing, and before the cartridge is installed in the system, carefully remove any
water from around the electrodes and cartridge body.
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Analyze the Data 7
Use an Analysis Parameters File to Analyze the
Data
Note: If the Waters Empower™ software will be used to acquire the data, then this procedure is
not applicable.

An analysis parameters file contains all of the information required to integrate the data and then
identify peaks.

Note: This procedure is for users who know how to use the BioPhase software. For detailed
instructions, refer to the document: Software Help System.

Note: The analysis parameters files in this procedure are examples. The parameters might not
be optimal for all data files.

1. On the Home page of the BioPhase software, click Data Analysis.
The BioPhase Analysis software main window opens.

2. Click File > Open, select the data files to analyze, and then click Open.

3. On the Project toolbar, click , browse to the analysis parameters files, and then click
Open.
Two analysis parameters files are available. Click the applicable file:

• data analysis with 50b as IST: Analyze the RNA ladder sample.

• data analysis with 50b point to point: Estimate the size of the unknown
RNA sample.

4. Right-click , and then select Apply & Analyze (all).

The software applies all of the parameters on the Integration, Library, and Post Analysis
tabs to all of the data files, and then shows the results.

In the Files pane, the file name is red to show that the data has been analyzed. The number
of peaks identified is shown in the Peaks column.

In the Data pane, the analysis results are shown in the table below the graph. At the top
of the table, RMS Noise, P-P Noise, and Drift are shown. In the graph, the baseline is red
and the threshold is a grey horizontal line. Any peaks identified in the analysis have a blue
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marker at the peak start, a red marker at the peal apex, and a green marker at the peak
end.

Peaks in the graph have the following shading:

• Green: The peak is identified as a peak in the Marker Table on the Library tab.

• Blue: The peak is identified as a peak in the Peak Table on the Library tab.

• Red: The peak is not a named peak.

Refer to the section: Examine the Results.

5. Show the peak names on the graph:

a. Right-click .
The Information Setup dialog opens.

b. Select Name and any other information to include on the graph, such as MT, and then
click OK.

c. Click .

The peak names are shown on the graph. Refer to the section: Examine the Results.

The names are part of the analysis parameters file. To use different names, refer to the
section "Identify the Peaks" in the document: Software Help System.

6. Click in the Files pane below the list of files, and then press the Up and Down arrow keys to
see the data for each file in the Data pane.
If required, drag over a region on the graph to zoom in to see the details of the identified
peaks in that region.

Tip! To use the same zoom settings to all of the data files, click .

7. Make sure that the integration is satisfactory. If required, then adjust the integration
parameters, and then analyze the data again.

8. Examine the electropherogram for the peaks in the Marker Table and Peak Table.

a. For each peak in the Marker Table and Peak Table, make sure that the correct peak has
a label in the graph.

b. If required, adjust MT in the Marker Table and MT (or Cal MT) in the Peak Table.

c. If required, adjust Tol and Crit, and then click .

• Tol is the tolerance used to find a match between a peak in the graph and a peak
in the Marker Table or the Peak Table. To use the tolerance as a percentage, type %
after the value.
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• Crit is the peak characteristic used to find a match.

• Ctr: The peak closest to the center of the range is used to find a match.

• Ht: The tallest peak in the range is used to find a match.

• Area: The largest peak in the range is used to find a match.

d. When the peak assignments are satisfactory, right-click , and then select Apply &
Analyze (all).

The software applies the changes to all of the data files.

9. (Optional) On the Project toolbar, click , type a name, select a location, and then click
OK.
The analysis parameters are saved to a file for later use.

10. (Optional) On the File toolbar, right-click , and then select Print (all).
The contents of the Data pane are printed in the active report template. For instructions to
create a report template, refer to the section "Configure a Report" in the document: Operator
Guide.

11. On the File toolbar, right-click , and then select Save (all).
All changes to the results are saved to the data files. The analysis parameters are included.

12. On the File toolbar, right-click , and then select Close (all).
All of the data files close.
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Examine the Results
Figure 7-1 ssRNA Ladder: Data Collected with Electrokinetic Injection

Figure 7-2 ssRNA Ladder: Data Collected with Pressure Injection
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Review the Results on the Overlay Tab
The Overlay tab shows the graphs for the selected data files. This tab has statistics for the
selected data files, as well as the system suitability report.

Note: This section does not describe the system suitability function. For information about
system suitability, refer to the document: Operator Guide.

1. Open a set of data files and the analysis parameters file, and then analyze the data. If
required, adjust the analysis parameters until the results are satisfactory.

2. In the Files pane, click , and then open the Overlay tab.

Figure 7-3 Overlay Tab

The color of the trace in the graph corresponds to the color in the circle next to the file name
in the Files pane.

The thicker line is the trace for the file selected in the Files pane.

3. To change the order of the files in the overlay, in the Files pane, click the file to be moved,
and then drag it up or down the list of files.

Note: The order of the colors assigned to the files does not change after a file is moved.

4. To adjust the distance between the traces, move the slider on the right side of the graph up
or down.

Note: To see the traces as a series of tiled graphs, move the slider all of the way to the top.
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Figure 7-4 Tiled Results
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5. Calculate the results for all of the files on the Overlay tab.

Figure 7-5 Results Table

Item Description

1 Reference file

2 Type of analysis

3 Save the results to a comma-separated file

a. To select the type of analysis, click the list on the right side of the Results Table header.

These options are available:

• Reference - All: In the Results Table, show statistics for every peak in the reference
file that is in all of the other data files.

• Reference - Peak Table: In the Results Table, show statistics for every named peak
in the reference file that is in all of the other data files.

• Named Peaks: In the Results Table, show statistics for all of the named peaks in the
data files.

• All Data (not displayed): Calculate but do not show statistics for all of the peaks in
all of the data files.

• System Suitability: System suitability testing is different than the other reports. For
more information, refer to the section "System Suitability Testing" in the documents:
Operator Guide or Software Help System.

If the migration times of the peak apexes in the data file are within 5% of the peak
apexes in the reference file, then a match is made.

b. To select the reference file, click the list on the left.

The reference file is the file to which all of the other files are compared.
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Only the Reference - All and Reference - Peak Table analyses use a reference file.

The Results Table changes to show the selected analysis or the system suitability report.

If All Data (not displayed) is selected, then the Results Table is empty. To see the results,
click Save to save the results to a comma-separated file, and then use another program
open the file.

6. (Optional) To use a different reference file or see a different type of analysis, do step 5
again.

7. (Optional) Click Save.
The Results Table is saved to a comma-separated text file. Only the columns that are shown
in the table are saved.

Note: To save the system suitability results, click File > Save Report. The results are saved
as a PDF.

8. (Optional) Click File > Print.
The contents of the Overlay tab are printed in the current report template.

9. (Optional) On the File toolbar, right-click , and then select Save (all).
All changes to the results and the analysis parameters are saved to the data files.

10. On the File toolbar, right-click , and then select Close (all).
All of the data files close.

Guidance for Acceptance Criteria
To create acceptance criteria for use with this kit for SOPs or other purposes, use parameters
that are inherent to the quality of the separation and attributes that show critical sample qualities.
Differences between gel and capillary lots and different systems might cause variations in
absolute migration times.

For the ssRNA ladder, the ratio between the migration time of the 9 kb and 0.5 kb peaks more
accurately reflects the apparent size of the nucleic acids in the gel and can be used to identify
the resolving power of the separation gel and consistency of the separation. SCIEX strongly
discourages the use of absolute migration time as an acceptance criterion.
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Run the Samples with the Waters
Empower™ Software 8
This section gives instructions for the use of the Waters Empower™ software and the BioPhase
8800 driver for Empower™ with the BioPhase 8800 system.

Import the BioPhase Software Methods to Create
Instrument Methods
Note: Methods created with the BioPhase software are supplied with the BioPhase 8800 driver
for Empower™. The methods are also available for download from the SCIEX website. Refer to
the section: Download and Configure the Required Files (Waters Empower™ Software).

Instrument methods can also be created in the Method Editors for BioPhase System software.
Refer to the documents: Operator Guide and Software Help System.

Typically, three types of methods are required: a conditioning method, separation method, and
shutdown method. For some workflows, there are more methods.

The following methods are available.

• Conditioning Method-RNA 9000: Conditions the capillaries before first use.

• Separation Method with Electrokinetic Injection - RNA 9000: Does the
separation of the sample with an electrokinetic injection of the sample.

• Separation Method - Pressure Injection - RNA 9000: Does the separation of
the sample with a pressure injection of the sample.

• Shutdown Method - RNA 9000: Cleans the capillaries at the end of a sequence, rinses
the capillaries for storage, and then turns off the lamp.

• Capillary Rinse - RNA 9000: Rinses the capillary between sequences, if required.

1. In the Waters Empower™ Software Project window, click File > New Method > Instrument
Method.
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Figure 8-1 Select Desired Chromatography System Dialog

2. Click the name of system to be used, and then click OK.
Make sure that the instrument is configured with an LIF detector.
The Instrument Method Editor opens.

3. Click Import, and then browse to the conditioning method.
The method opens in the Instrument Method Editor with the Method Settings tab in front.

Note: The Instrument Method Editor window is read-only. If changes to the method are
required, then save the instrument method, and then edit the method in the Method Editors
for BioPhase System software. Refer to the section: "Edit an Existing Instrument Method" in
the document: Software Help.
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Figure 8-2 Instrument Method Editor: Method Settings

4. (Optional) To see the actions, open the Method Program tab.

5. To see the parameters for an action, click the row in the table.
The Parameters pane changes to show the parameters.

Figure 8-3 Instrument Method Editor: Method Program
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6. Save the conditioning instrument method:

a. Click File > Save with Method Set.
The Save current Instrument Method dialog opens.

b. In the Name field, type a name.

Note: The name must be less than 30 characters and can contain alphanumeric
characters, spaces, and the special characters @, _, and %. Some versions of
the Waters Empower™ software accept more than 30 characters and other special
characters. If the method is edited in the Method Editors for BioPhase System software,
then those characters might cause issues.

c. (Optional) In the Method Comments field, type the information.

d. If a prompt is shown, then in the Password field, type the Waters Empower™ software
password for the current user, and then click Save.

The instrument method and method set are saved to the current project.

7. Click File > Exit.

Note: After a method has been imported, the Import button in the Instrument Method Editor
is not available unless the window is closed and then opened again.

8. To create the other instrument methods and method sets, repeat steps 3 through 7.

Create the Sample Set Method
Note: A sample set method requires method sets. Make sure that any required instrument
method is part of a method set.

This procedure gives instructions for creating a sample set method with the ssRNA Ladder in the
first column, followed by 16 samples in the second and third columns.

1. In the Waters Empower™ Software Run Samples window, click BioPhase 8800 > BioPhase
Sample Set Editor.

The Method Editors for BioPhase System software opens, to the Sample Set Method Editor
workspace.

2. Click New Sample Set Method.
The Sample Set Method Editor opens to the Sample Plate Setup tab.

3. In first row of the Sample Set Summary table, click the Method Set Name cell, and then
select Conditioning Method-RNA 9000.

4. In the Sample Plate Layout pane, click 1.
The first column in the sample plate is selected and the Sample Set Summary table
changes to show the selected wells.
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Figure 8-4 Sample Plate Layout Pane

5. In the Sample Set Summary table add the required sample information. In row 2 through
row 9, do the following:

a. In the Sample Name cell, type a name.

b. Click the Method Set Name cell, and then select Separation Method with
Electrokinetic Injection - RNA 9000 or another separation method.

Tip! After the method set is selected for row 2, right-click and select Apply method to
all samples in column to assign the method to all of the samples.

6. Repeat, steps 4 and 5 twice, for column 2 and then for column 3.

7. In the last row, click the Method Set Name cell, and then select Shutdown Method -
RNA 9000.

Note: The following figure does not show the entire sample set method.
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Figure 8-5 Sample Set Summary Table

8. If the Validation pane is shown, then click the pane to see the errors. Click an error to
identify where it occurs, and then make the required change.
If there are no errors, then the Validation pane is not shown.

9. Save the sample set method:

a. Click SAVE AS.

Note: If errors occurred, then the SAVE AS button is not available. Correct all of the
errors in the Validation pane, and then click SAVE AS.

The Save Sample Set dialog opens.

b. In the Sample Set Name field, type a name.
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Note: The name must be less than 30 characters and can contain alphanumeric
characters, spaces, and the special characters @, _, and %. Some versions of
the Waters Empower™ software accept more than 30 characters and other special
characters. If the method is edited in the Method Editors for BioPhase System software,
then those characters might cause issues.

c. (Optional) In the Description field, type information.

d. Click Save.

e. To acknowledge the saved method, click OK.

The sample set method is saved to the Waters Empower™ software database.

10. To see, save, or print the plate layouts:

a. Open the Plate Layouts tab.

b. (Optional) Click PRINT.
The Print Preview window opens.

c. If required, click the applicable button to print or save the plate layouts.
Refer to the section: "Print Preview Dialog" in the document: Software Help System.

d. Close the Print Preview dialog.

11. Close the Method Editors for BioPhase System software.
The Run Samples window is shown.

Start the Sample Set Method
1. Load the cartridge and plates. Refer to the section: Prepare the BioPhase 8800 System.

2. In the Waters Empower™ software Project window, click Tools > Run Samples.
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Figure 8-6 Select Desired Chromatography System Dialog

3. Click the name of the system to be used, and then click OK.
The Run Samples window opens.

4. Configure the plate type:

a. Click Edit > Plates.

Figure 8-7 Define Plates for Sample Set Method Dialog
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Note: If the dialog does not look like the preceding figure, then clear the 2790 Layout
check box.

b. Click the Plate Type Name cell, and then select ANSI-96well2mL.
The dialog changes with an image of the plate and buttons for the plate sequencing
mode.

c. Click the Plate Layout Position cell, and then type 1.

d. To set the order of access for the wells during the run, click .

e. To save the changes, click OK.

f. Close the dialog.

Tip! To permanently configure the plate type, click Customize > Defaults, click Plates. In
the Define Plates For Sample Set Method dialog, do steps 4.b through 4.e, and then, in the
Run Samples Defaults dialog, click OK.

In the Sample Set Method table, the heading for the Vials column changes to Plate/Well.

5. Click  (Load Sample Set).

Figure 8-8 Load Samples Dialog

6. Click Load using a previously created sample set method, and then click OK.
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Figure 8-9 Open an existing sample set method Dialog

7. Click RNA 9000 Kit Sample Set Method, and then click Open.
The sample set method opens in the Samples tab.

8. (Optional) Configure the table to show only the columns that are relevant for the BioPhase
8800 system:

a. Right-click, and then select Table Properties.
The Table Properties dialog opens.

b. Click Hide All, and then clear the Plate/Well, # of Injs, SampleName, Function, and
Method Set / Report or Export Method check boxes.

c. Click OK.

The table changes to show the selected columns.
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Figure 8-10 Samples Tab

9. Review the sample set method. Make sure that the correct reagent plate layout was used.
If changes are required, then edit the method in the Method Editors for BioPhase System
software. Changes to the instrument methods or method sets are automatically transmitted
to the sample set method.

10. In the Waters Empower™ Software Project window, click  (Start).
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Figure 8-11 Run Sample Set Dialog

11. If required, edit the information:

a. If required, edit the Name for this sample set field.

b. (Optional) Click Shutdown Method, and then select Capillary Rinse - RNA
9000, an instrument method that rinses the capillaries.
If the system encounters an error during a run, then it executes this instrument method,
and then stops the run.

c. If required, select Do Not Run Shutdown Method During User Abort.

d. Click Run.

The run starts. During the run, in the Sample Set Method window, the text in the row for the
sample being acquired is red.

CAUTION: Potential Data Loss. During a run, do not start any actions from the
BioPhase 8800 driver for Empower™ Direct Control pane, even if the system status
is idle. Any actions that are started might cause interference with data acquisition.
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Monitor the Run in the Waters Empower™

Software
CAUTION: Potential Data Loss. Do not stop the run until all of the data is saved. The data
is saved when the sample set method is on the next row.

CAUTION: Potential System Damage. If the run is stopped and will not be started again,
then use the shutdown method to rinse the capillaries before the cartridge is stowed. If
the capillaries are not rinsed, then electrolyte salt crystals or precipitate can collect and
might cause blocked capillaries, incorrect pressure sealing, errors when the samples are
injected, arcing, or current leakage.

CAUTION: Potential System Damage. Before the run is started again, make sure to empty
or replace the outlet plate to prevent the overflow of reagent and possible damage to the
instrument.

CAUTION: Potential Wrong Result. Before the run is started again, prepare new reagent
plates. If the run has been stopped, then there might not be sufficient reagents available
to complete the run.

CAUTION: Potential Wrong Result. If the samples have been inside of the system for
more than 24 hours, sample degradation might have occurred. Discoursed the samples
before the run is started again.

Use this procedure to monitor the progress of the sample set method, and then, if required, stop
or pause the sample set method.

Note: Most of the panes in the Waters Empower™ software are made for chromatography. Use
the following steps to monitor the progress of the capillary electrophoresis separation and ignore
the information in the Time Remaining and Solvent Required panes.

1. To stop the run, click  (Abort).

Note: Do not use the Stop button in the Direct Control pane. That button is only applicable
to functions that are started from the Direct Control pane.
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Figure 8-12 Abort Options Dialog

When the run ends, the text in all of the rows in the Sample Set Method window is red.

2. To see the data during acquisition, in the Direct Control pane, click  (Monitor).

Figure 8-13 Trace View Window
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3. If required, do any of the following:

• To see current, voltage, or pressure, open the applicable tab in the top left.

• To see one graph with the data for all of the capillaries, in the bottom left, click Overlay.

• To see data for some of the capillaries, select or clear the check boxes at the bottom of
the window for the capillaries of interest.

• To see the time and detector values for any point on a trace, click the trace at the position
of interest.

• To zoom in on the data, make sure that Overlay is selected, and then drag to select the
area to zoom. The mouse scroll wheel can also be used to zoom.

• To go back to the original data dimensions, in the bottom right, click Reset Zoom.

• To see a different area of a zoomed plot, right-click the X- or Y-axis, and then drag.

4. If required, at the bottom right, right-click Auto Zero.
The detector signal is set to zero.

5. Wait until  (Abort) changes to  (Start).
A delay between data acquisition and when all of the data is saved might occur. The green
button identifies that all of the data is saved.

6. If required, discard the samples and reagents. Refer to the section: Waste Disposal.

7. If required, stow the cartridge. Refer to the section: Stow the Cartridge After the Run.
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Troubleshooting 9
After each corrective action is complete, we recommend that the analysis be done again to
make sure that the symptom has been corrected.

Note: SYBR™ is a trademark of the Life Technologies Corporation. SYBR™ Green II RNA Gel
Stain is not available for resale.

Symptom Possible Cause Corrective Action

Cartridge not
detected error

1. The ID chip on the cartridge is
not clean.

2. The contact pins on the
system are not clean.

3. The BioPhase 8800 system
firmware is not up to date.

1. Moisten a lint-free laboratory
wipe or cotton swab with
ethanol or isopropanol, and then
clean the surface of the ID chip.
Let the ID chip air-dry before the
cartridge is installed.

2. Moisten a lint-free laboratory
wipe or cotton swab with
ethanol or isopropanol, and then
clean the contact pins. Let the
pins air-dry before the cartridge
is installed.

3. Do the following:

a. On the BioPhase 8800
system front panel, touch
the icon in the top left
corner.

b. Record the firmware
version.

c. Contact sciex.com/request-
support.
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Symptom Possible Cause Corrective Action

Error found at start
of run

1. The optical scan at the
beginning of the run failed
because of condensation on
the cartridge window.

2. When the optics door was
opened and closed, a sensor
error occurred.

1. In the shutdown method,
increase the Sample Storage
temperature to 20 °C to prevent
condensation.

2. Turn off, and then turn on the
BioPhase 8800 system.

To prevent this from occurring
again, always use the applicable
procedure to change the filters.
Refer to the sections: "Install
a UV Filter" and "Install the
Filters for the LIF Detector" in
the document: Operator Guide.
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Symptom Possible Cause Corrective Action

Broad peaks, poor
resolution

1. The capillary tip is damaged.

2. The sample concentration is
too high.

3. The capillary is blocked.

4. The internal surface of the
capillary is contaminated.

1. Do the following actions:

• Use a magnifying lens to
examine the capillary tip.

• Use a lint-free laboratory
wipe to clean the capillary
inlets carefully in an outward
direction.

• Make sure that the capillary
tip extends approximately
2 mm from the gold cannula
electrode.

• Make sure that the capillary
tip has a straight cut and is
not broken. If the capillary
cannot be used, then refer
to the section: Options for
a Blocked or Damaged
Capillary.

2. Do one or all of the following:

• Decrease the Duration in
the Inject action in the
separation method to inject
less sample. If the results
are not satisfactory, then
decrease the Pressure or
Voltage.

• Dilute the sample again with
the sample diluent.

3. Refer to the section: Options
for a Blocked or Damaged
Capillary.

4. Edit the sequence to omit
the contaminated capillary or
replace the cartridge.
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Symptom Possible Cause Corrective Action

Broad peaks,
poor resolution
(continued)

1. The cartridge is no longer
serviceable.

2. The SYBR™ Green II RNA
Gel Stain concentration in the
gel buffer is too high.

3. The Nucleic Acid Extended
Range Gel was kept at
ambient temperature too long.

4. The capillary cartridge was
kept at ambient temperature
for more than a week.

1. Do a test separation of the
ssRNA Ladder. If the peak
widths are consistently wider
than previous runs, then replace
the cartridge.

2. Make sure that the SYBR™

Green II RNA Gel Stain is
diluted between 100× and
1000× in the gel buffer. Refer to
the section: Load the Reagent
Inlet and Outlet Plates

3. Prepare new Nucleic Acid
Extended Range Gel. Make
sure to keep it between 2 °C
and 8 °C. Minimize the time
that the gel is at ambient
temperature.

4. Replace the cartridge.
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Symptom Possible Cause Corrective Action

Carryover 1. The sample concentration is
too high.

2. The reagent plate is
contaminated with sample.

1. Do one or all of the following:

• Decrease the Duration in
the Inject action in the
separation method to inject
less sample. If the results
are not satisfactory, then
decrease the Pressure or
Voltage.

• Dilute the sample again with
the sample diluent.

2. In the separation method, add
one or more water dip steps
after sample injection. With the
edited method, do the following
steps:

a. Create a new sequence
that uses this separation
method.

b. Prepare new reagent plates
for the new sequence.
Refer to the section: Load
the Reagent Inlet and
Outlet Plates.

Extra peaks 1. Non-nucleic acid components
of the sample interacted with
the dye.

2. The plasticware used during
sample preparation or the
sample plate is contaminated
with materials that interact
with the dye.

3. Light scattering caused by
particulates larger than 1 μm
in the gel buffer occurred.

1. Prepare the sample again.
Make sure that it is pure.

2. Use clean plasticware and a
clean sample plate to prepare
the sample again.

3. Before the gel buffer is added
to the reagent plates, put
the sample through a syringe
filter with a 0.45 μm pore-size
membrane.
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Symptom Possible Cause Corrective Action

High current 1. The gel buffer is
contaminated.

2. The positions of the reagents
in the reagent plate do not
agree with the plate layouts in
the sequence.

3. The Nucleic Acid Extended
Range Gel was kept at
ambient temperature too long.

1. Prepare the inlet and outlet
reagent plates again to replace
the gel buffer.

2. Make sure that the positions
of the reagents in the reagent
plates agree with the plate
layouts. If the positions are
not correct, then use the plate
layout to prepare the plates
again. Refer to the section:
Plate Layouts.

3. Prepare new Nucleic Acid
Extended Range Gel. Make
sure to keep it between 2 °C
and 8 °C. Minimize the time
that the gel is at ambient
temperature.
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Symptom Possible Cause Corrective Action

Low signal 1. The capillary tip is dirty or
plugged.

2. The sample volume is too low.

3. The salt concentration in the
sample is too high.

4. The initial nucleic acid
concentration is too low.

5. Degradation of the nucleic
acids in the sample occurred
because of exposure to
RNAse or other nucleases.

1. Rinse the capillary. Refer to
the section: Remove Blockage
from a Capillary. Do a blank
separation run to equilibrate the
capillary surface.

2. Make sure that there is a
minimum of 50 µL of sample in
the sample well.

3. Do one or all of the following:

• If the separation method
uses an electrokinetic
injection, then use a pressure
injection.

• Prepare the sample at a
lower ionic strength.

4. Do one or all of the following:

• Increase the Duration up
to 15 seconds in the Inject
action in the separation
method to inject more
sample. If the results are not
satisfactory, then increase
the Pressure or Voltage.

• Prepare the sample again,
with the recommended
concentration. The
recommended concentration
is 50 ng/mL to 50 μg/mL.

5. Prepare the sample again.
Make sure that the sample is
not exposed to RNase. Refer to
the section: Best Practices for
Working with RNA.
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Symptom Possible Cause Corrective Action

Low current 1. The capillary is blocked.

2. The position of the gel buffer
in the reagent plate does not
agree with the sequence.

1. Refer to the section: Remove
Blockage from a Capillary.

2. Make sure that the position of
the gel buffer during the voltage
separation step is correct. If the
positions are not correct, then
use the plate layout to prepare
the plates again. Refer to the
section: Load the Reagent Inlet
and Outlet Plates.

Low or unsteady
current

1. The capillary tip is blocked or
contaminated.

2. The gel buffer has air
bubbles.

1. Refer to the section: Remove
Blockage from a Capillary. If the
current is low or unsteady, then
replace the cartridge.

2. Do one or all of the following:

• Use a centrifuge to spin the
plate at 30 × g for 5 minutes
to remove air bubbles.

• De-gas the gel buffer with
5 inches Hg to 15 inches Hg
vacuum for 5 minutes.
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Symptom Possible Cause Corrective Action

No electrical current
during separation

1. The capillary is damaged.

2. The electrode is broken or
bent.

3. The capillary tip is blocked or
contaminated.

4. The positions of the reagents
in the reagent plate do not
agree with the plate layouts in
the sequence.

5. A capillary is filled with air
bubbles.

1. Refer to the section: Options
for a Blocked or Damaged
Capillary.

2. Replace the cartridge.

3. Refer to the section: Remove
Blockage from a Capillary.

4. Make sure that the positions
of the samples and reagents
in the plates agree with the
plate layouts. If the positions are
not correct, then use the plate
layout to prepare the plates
again. Refer to the section:
Plate Layouts.

5. Do one or all of the following:

• Make sure that the wells
of the sample and reagent
plates contain sufficient
solution.

• Make sure that the positions
of the reagents in the reagent
plates agree with the plate
layouts. If the positions are
not correct, then use the
plate layout to prepare the
plates again. Refer to the
section: Plate Layouts.

• Use a centrifuge to spin the
plate at 30 × g for 5 minutes
to remove air bubbles.
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Symptom Possible Cause Corrective Action

No peaks 1. The lifetime of the LIF
detector laser has been
exceeded.

2. The wavelength of the
emission filter is not correct.

3. The method parameters are
incorrect.

4. Air bubbles in a well of the
sample plate prevent sample
injection.

5. The capillary window is
blocked.

6. A capillary is blocked and has
a low current.

7. The sample volume is too low.

8. The capillary was cleaned
with a basic solution such as
0.1 N NaOH.

1. Contact SCIEX Technical
Support at sciex.com/request-
support.

2. Make sure that the emission
filter wavelength is 520 nm.

3. Do the following:

• Open the separation method
in the software, and then
make sure that the method
is correct. Refer to the
section: Separation Method
with Pressure Injection or
Separation Method with
Electrokinetic Injection.

• Make sure that the positions
of the samples and reagents
in the plates agree with the
plate layouts. If the positions
are not correct, then use the
plate layout to prepare the
plates again. Refer to the
section: Plate Layouts.

4. Use a centrifuge to spin the
plate at 30 × g for 5 minutes to
remove air bubbles.

5. Examine the capillary window.
Make sure that the window is
clean and the path is clear.
Refer to the section: Examine
the Capillary Cartridge.

6. Refer to the section: Options
for a Blocked or Damaged
Capillary.

7. Make sure that there is 100 µL
of sample in the sample well.

8. Replace the cartridge.

Troubleshooting

Application Guide
RUO-IDV-05-13438-D

RNA 9000 Purity & Integrity Kit For the BioPhase 8800
System

75/93

https://sciex.com/request-support
https://sciex.com/request-support


Symptom Possible Cause Corrective Action

No peaks
(continued)

1. There is no sample in a
sample well, or the position
of the samples in the sample
plate do not agree with the
plate layouts in the sequence.

2. A pipetting error occurred
during preparation of the
sample.

3. The salt concentration in the
sample is too high.

1. Make sure that the position of
the samples in the sample plate
agrees with the plate layout. If
the positions are not correct,
then use the plate layout to
prepare the plates again. Refer
to the section: Plate Layouts.

2. Prepare a new sample.

3. Do one or all of the following:

• If the separation method
uses an electrokinetic
injection, then use a pressure
injection.

• Prepare the sample again at
a lower ionic strength.

Slower migration
time, with or
without concurrent
low current

1. The capillary tip is blocked or
contaminated.

1. Refer to the section: Remove
Blockage from a Capillary.

Dramatic shift in
migration time
between runs on the
same day

1. The capillary has not been
conditioned sufficiently.

2. The gel buffer has
evaporated.

1. Condition the capillary. Refer
to the section: Condition
the Capillaries. Do a blank
separation run to equilibrate the
capillary surface.

2. Prepare new reagent plates with
fresh gel buffer. Decrease the
interval between loading the
new reagent plates and running
a sample to minimize the on-
instrument time for the reagent
plates.
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Symptom Possible Cause Corrective Action

Spikes in
electropherogram

1. The gel buffer has air
bubbles.

1. Do one or all of the following:

• Use a centrifuge to spin the
plate at 30 × g for 5 minutes
to remove air bubbles.

• De-gas the gel buffer with
5 inches Hg to 15 inches Hg
vacuum for 5 minutes.

If air bubbles are still present,
then prepare new gel buffer. Do
not mix the buffer with a vortex
mixer. Carefully invert the tube a
minimum of 20 times.

Broad or split peaks 1. After the denaturation step,
there is still secondary
structure in the nucleic acid.

2. The cooling step after
denaturation was too slow.

3. The SYBR™ Green II RNA
Gel Stain concentration in the
gel buffer is too high.

4. The cartridge is no longer
serviceable.

1. Dilute the samples with Sample
Loading Solution in place of
nuclease-free water.

2. Cool the samples immediately
to prevent the formation of
secondary structure.

3. Make sure that the SYBR™

Green II RNA Gel Stain is
diluted between 100× and
1000× in the gel buffer. Refer to
the section: Load the Reagent
Inlet and Outlet Plates.

4. Do a test separation of the
ssRNA Ladder. If the peak
widths are consistently wider
than previous runs, then replace
the cartridge.

Troubleshooting
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Symptom Possible Cause Corrective Action

Saturated peaks 1. In the Method Settings for
the separation method, the
PMT Gain is too high.

2. The sample concentration is
too high.

1. Decrease the value for the PMT
Gain.

2. Do one or all of the following:

• Decrease the Duration in
the Inject action in the
separation method to inject
less sample. If the results
are not satisfactory, then
decrease the Pressure or
Voltage.

• Dilute the sample again with
the sample diluent.

Unstable baseline 1. The concentration of dye in
the inlet reagent plate is not
the same as the concentration
in the outlet reagent plate.

1. Prepare sufficient gel buffer for
both the inlet and outlet reagent
plates.

Remove Blockage from a Capillary
1. Rinse the capillary with CE Grade water at 75 psi for 10 minutes.

2. Use CE Grade water to clean the capillary inlets.

3. Use a lint-free laboratory wipe to clean the capillary inlets carefully in an outward direction.

4. If the blockage cannot be removed, then edit the sequence to ignore the damaged capillary
or replace the cartridge.

Options for a Blocked or Damaged Capillary
If blockage in a capillary cannot be removed or a capillary is damaged, then edit the sequence to
omit the blocked or damaged capillary. Refer to the section: Create the Sequence.

Troubleshooting

RNA 9000 Purity & Integrity Kit For the BioPhase 8800
System
78/93

Application Guide
RUO-IDV-05-13438-D



Hazardous Substance Information A
The following information must be noted and the relevant safety measures must be obeyed. For
more information, refer to the respective safety data sheets. The safety data sheets are available
on request or can be downloaded from our website, at sciex.com/tech-regulatory.

Hazard classification according to HCS 2012.

Acid wash/regenerating solution

DANGER! Causes severe skin burns and eye damage.

Nucleic Acid Extended Range Gel

DANGER! May damage fertility or the unborn child.

SYBR™ Green II RNA Gel Stain5

WARNING! Combustible liquid.

Other Reagents

These components are not classified as hazardous:

• CE Grade water

• LIF Performance Test Mix

For reagents from other vendors, read the safety data sheet from the vendor before use.

5 SYBR™ is a trademark of the Life Technologies Corporation. SYBR™ Green II RNA Gel Stain is not available for
resale.
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Download Required Files B
Do the procedure for the software in use:

• BioPhase software: Refer to the section: Download and Configure the Required Files
(BioPhase Software).

• Waters Empower™ software: Refer to the section: Download and Configure the Required
Files (Waters Empower™ Software).

Download and Configure the Required Files
(BioPhase Software)
Files with methods, sequences, reagents, and analysis parameters for the RNA 9000 Purity &
Integrity kit are available at sciex.com. Use the following instructions to download, extract, and
then copy the files to the applicable location.

Note: The following procedure is only required when BioPhase software 1.1 is used. The
required files for the RNA 9000 Purity & Integrity kit are included as part of the BioPhase
software 1.2 or later.

1. Go to sciex.com/software-downloads. In the More software downloads section, click
BioPhase Resources.

2. Click BioPhase Project Files 1.4.

3. In File Explorer, right-click the BioPhase 1.4.zip file, and then click Extract All.

4. Browse to a location, click Select Folder, and then click Extract.
The extracted files are copied to the selected file path.

5. Move the extracted files to the correct locations:

Note: The following instructions use the default location C:\Biophase for the BioPhase
software files. If the project folders are in a different location, then put the extracted files in
that location.

a. Drag the BioPhase 1.4\Projects\RNA 9000 folder to the
C:\BioPhase\Projects folder.

b. Drag the BioPhase 1.4\Reagents\RNA 9000 folder to the
C:\BioPhase\Reagents folder.

c. Drag the BioPhase 1.4\Data Analysis\RNA 9000 folder to the
C:\BioPhase\Data Analysis folder.

Download Required Files

RNA 9000 Purity & Integrity Kit For the BioPhase 8800
System
80/93

Application Guide
RUO-IDV-05-13438-D

https://sciex.com


Download and Configure the Required Files
(Waters Empower™ Software)
Files for the RNA 9000 Purity & Integrity kit are available on sciex.com. Use the following
instructions to download, extract, and then copy the files to the applicable location.

1. Go to sciex.com/software-downloads. In the More software downloads section, click
BioPhase Driver Resources.

2. Click BioPhase Method Files 1.4.

3. In File Explorer, right-click the BioPhase-Empower-Method-Files-1.4.zip file, and
then click Extract All.

4. Browse to the location to save the method files, click Select Folder, and then click Extract.
The files are extracted and then copied to the specified location.

Download Required Files
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Reagents, Plate Layouts, and
Methods C
Reagent Set
If the reagents are not available, then use the following figures to create a new reagent set.

Figure C-1 RNA 9000 Purity & Integrity Kit Inlet Reagents

Figure C-2 RNA 9000 Purity & Integrity Kit Outlet Reagents

Reagents, Plate Layouts, and Methods
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Plate Layouts
Note: The following figures show the plate layouts for the sequence supplied with the software.
If more samples have been added or the reagent positions have been changed, then the
following layouts are not correct.

Sample Plates

Note: The top row shows the layout for the sample outlet plate. The bottom section shows the
layout for the sample inlet plate.

Figure C-3 Layouts for the Sample Inlet Plate and Sample Outlet Plate
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Reagent Plates

Note: The top row shows the layout for the reagent outlet plate. The bottom section shows the
layout for the reagent inlet plate.

Figure C-4 Layouts for the Reagent Inlet Plate and Reagent Outlet Plate

Reagents, Plate Layouts, and Methods
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Methods
For instructions to create a method, refer to the document: Software Help System.

Conditioning Method
Figure C-5 Method Settings for the Conditioning Method

Figure C-6 Actions in the Program Pane for the Conditioning Method
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Figure C-7 Summary of Actions in the Conditioning Method

Separation Method with Electrokinetic Injection
Figure C-8 Method Settings for the Separation Method with Electrokinetic Injection

Reagents, Plate Layouts, and Methods
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Figure C-9 Actions in Program Pane for the Separation Method with Electrokinetic
Injection

Figure C-10 Summary of Actions in the Separation Method with Electrokinetic Injection

Reagents, Plate Layouts, and Methods

Application Guide
RUO-IDV-05-13438-D

RNA 9000 Purity & Integrity Kit For the BioPhase 8800
System

87/93



Separation Method with Pressure Injection
Figure C-11 Method Settings for the Separation Method with Pressure Injection

Figure C-12 Actions in Program Pane for the Separation Method with Pressure Injection
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Figure C-13 Summary of Actions in the Separation Method with Pressure Injection

Shutdown Method
Figure C-14 Method Settings for the Shutdown Method
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Figure C-15 Actions in the Program Pane for the Shutdown Method

Figure C-16 Summary of Actions in the Shutdown Method

Capillary Rinse Method
Figure C-17 Method Settings for the Capillary Rinse Method
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Figure C-18 Actions in the Program Pane for the Capillary Rinse Method

Figure C-19 Summary of Actions in the Capillary Rinse Method
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Contact Us

Customer Training
• In North America: NA.CustomerTraining@sciex.com

• In Europe: Europe.CustomerTraining@sciex.com

• Outside the EU and North America, visit sciex.com/education for contact information.

Online Learning Center
• SCIEX Now Learning Hub

Purchase Supplies and Reagents
Reorder SCIEX supplies and reagents online at store.sciex.com. To set up an order, use the
account number, found on the quote, order confirmation, or shipping documents. Currently,
customers in the United States, Canada, United Kingdom, Belgium, Netherlands, France,
Germany, and Switzerland have access to the online store, but access will be extended to other
countries in the future. For customers in other countries, contact a local SCIEX representative.

SCIEX Support
SCIEX and its representatives maintain a staff of fully-trained service and technical specialists
located throughout the world. They can answer questions about the system or any technical
issues that might arise. For more information, visit the SCIEX website at sciex.com or contact us
in one of the following ways:

• sciex.com/contact-us

• sciex.com/request-support

Cybersecurity
For the latest guidance on cybersecurity for SCIEX products, visit sciex.com/productsecurity.

Documentation
This version of the document supersedes all previous versions of this document.

To see this document electronically, Adobe Acrobat Reader is required. To download the latest
version, go to https://get.adobe.com/reader.

Contact Us
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To find software product documentation, refer to the release notes or software installation guide
that comes with the software.

To find hardware product documentation, refer to the documentation that comes with the system
or component.

The latest versions of the documentation are available on the SCIEX website, at sciex.com/
customer-documents.

Note: To request a free, printed version of this document, contact sciex.com/contact-us.
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